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Dermoscopy (dermatoscopy, skin surface microscopy) is a non-invasive diagnostic technique for thein vivo
observation of pigmented skin lesions, allowing a better visualization of the surface and subsurface structures.
In the last few years, several computer-aided diagnosis systems of digital dermoscopic images have been in-
troduced, since the interpretation of dermoscopic images is time consuming and subjective (even for trained
dermatologists), and also to reduce the learning-curve of non-expert dermatologists. The validation of these
algorithms requires a ground-truth database of manually segmented images. Therefore, this situation calls up
for the development of new tools that can support the manual segmentation, making this task easier and faster to
the dermatologists. In this paper, we present a graphical user interface for computer-aided manual segmentation
of dermoscopic images that can easily be adapted to other medical images. This tools allows building up a
reliable ground truth database of manually segmented images. Besides the manual segmentation of the lesion,
this tool allows performing the segmentation of other specific regions of interest, which are essential for the
development of newly computer-aided diagnosis systems.

1 INTRODUCTION
Currently, dermoscopy, also known to as der-
matoscopy, epiluminescence microscopy, or skin sur-
face microscopy, is clinically the most relevantin
vivo imaging technique for melanoma diagnosis. Der-
moscopy is a non-invasive technique for the observa-
tion of pigmented skin lesions, allowing a better visu-
alization of the surface and subsurface structures, and
the recognition of morphologic structures not visible
by the naked eye (Argenziano 2000).

The dermoscopic diagnosis of pigmented skin le-
sions is currently performed by trained dermatologists
based on a set on pattern analysis criteria such as the
ABCD rule or the seven point check list. Both ap-
proaches involve a visual analysis of the skin lesion
in which the lesions are evaluated according to sev-
eral properties, such as the asymmetry, the border ir-
regularity, the color, the diameter, and the presence of
atypical vascular pattern or irregular diffuse pigmen-
tation (Argenziano 1998).

The standard approach in dermoscopic image anal-
ysis has usually three stages: (i) image segmentation,
(ii) feature extraction and feature selection, (iii) lesion
classification (Mendonca 2007). The first step is one
of the most important because the accuracy of the sub-

sequent steps depends on image segmentation which
permits the extraction of the lesion from the surround-
ing skin.

However, segmentation is a challenging task due
to several reasons. Among these are the great vari-
ety of lesion shapes, sizes, and colors along with dif-
ferent skin types and textures. In addition, some le-
sions have irregular and fuzzy boundaries and in some
case there is a low contrast between the lesion and
the surrounding skin. Moreover, some images con-
tain intrinsic cutaneous features such as black frames,
skin lines, blood vessel hairs, and air bubbles (Celebi
2009) (Silveira 2009).

Nowadays some commercial applications are al-
ready available for the automatic (or semi-automatic)
segmentation of dermoscopic images. However they
are not yet widely used as they are not considered to
be trustworthy. This situation calls up for the develop-
ment of more sophisticated automatic technique, but
also for the implementation of automatic tools to sup-
port manual segmentation.

The tool presented in this paper will allow build-
ing up a reliable ground truth database of manually
segmented images to be used with multiple purposes.
Among these are the assessment of the accuracy of
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Figure 1:Image on the left: initial contour drawn by the user, with some undesirable extra lines (marked with circles).
Image on the right: final contour after morphological filtering. Note that the final contour is smoother than the initial and
without undesirable extra lines.Toolbar Buttons: 1-“Load Images”; 2-“Save as”; 3-“Zoom in”; 4-“Zoom out”; 5-“Manual
segmentation”; 6-“Pointwise boundary reshaping”; 7-“Local boundary reshaping”.

newly developed automatic segmentation methods, as
well as the use in medical training. Besides the iden-
tification of the lesion borders, this tool also allows
marking other specific regions of interest, such as re-
gions with typical or atypical vascular networks, dots,
globules, star burst patterns, etc, whose recognition is
crucial for further classification.

2 INTERFACE DESCRIPTION
This application allows performing the manual seg-
mentation of dermoscopic images and storing the re-
sult of segmentation. For this, the user has a set of
tools to be used sequentially to achieve the desired
result.

The main functionalities of this interface are:

• Image upload and display

• Manual segmentation

• Boundary reshaping

• Storage of segmented image

The interface was implemented in a MATLAB en-
vironment (7.9.0 R2009b) because of its image pro-
cessing toolbox and graphical facilities.

2.1 Image upload and display
With this application it is possible to open one image
or several images at once. For this, it is necessary to
select the option “Load images” in the “File” menu,
or simply press the button 1 on the toolbar, Figure

1. Then a dialog box appears that enables the user to
browse and select the image to be segmented. To open
multiple images, simply press CTRL key and select
the desired images.

The loaded image is displayed on the left side of the
interface. If several images have been loaded, the user
can easily change the image that is being displayed
through the slider button, Figure 1.

2.2 Manual Segmentation

In order to perform the manual segmentation, this ap-
plication allows to draw a freehand region of inter-
est on the loaded image. It is important to note that
the manual segmentation can be performed using a
pen tablet or a mouse. The user can choose between
performing the manual segmentation of the lesion or
other regions of interest through the radio buttons on
the panel “Segmentation”.

To achieve the manual segmentation it is necessary
to select in the “Tools” menu the option “Manual Seg-
mentation”, or simply press button 5 on the toolbar,
Figure 1. Then, the user must click and drag the pen
tablet to draw the contour of the lesion (or the contour
of other regions of interest).

When the user confirms the segmentation, the im-
age with the final contour is displayed on the right
side of the interface, Figure 1. Note that the user can
only confirm and complete the segmentation when a
closed contour is drawn. When the user lifts the pen
from the tablet before closing the contour, the contour
remains open. However, while the contour is open the
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Figure 2:Image on the left: Initial contour (solid line) and the reshaped contour (with control points).Image on the
right: final contour.

user has the possibility of drawing until he/she com-
pletes and closes it.

To obtain the final contour from the initial one
(drawn by user), a binary mask of the initial contour
is first created, and then a morphological filtering is
applied to this binary mask. The purpose of morpho-
logical filtering is smoothing and removing extra lines
that not belong to the contour. These lines may arise
when the contour is drawn by means of multiple seg-
ments, especially at the points of intersection of these
segments, Figure 1.

Basically, morphological filtering is divided into
three stages (i) morphological erosion; (ii) selection
of the biggest binary object from the image and (iii)
morphological dilation. The user also has the possi-
bility to select the degree of smoothing between low,
medium and high. In each of these morphological op-
erations a flat disk-shaped structuring element is used,
with a specific radius for each smoothing level (low:
radius 1; medium: radius 3; high: radius 7).

The manual segmentation of other regions of in-
terest can be done in a very similar way to the man-
ual segmentation of the lesion. The main difference is
that the contours of all segmented regions are shown
on the same image with a different color. For this pur-
pose, the user must select the “Other regions of inter-
est” radio button in the panel “Segmentation”.

2.3 Boundary reshaping

Even after finishing the manual segmentation it is pos-
sible to make some adjustments in the contour, if nec-
essary. Two distinct methods were implemented to re-
shape the contour previously done, namely “Point-

wise boundary reshaping” and “Local boundary re-
shaping”.

2.3.1 Pointwise boundary reshaping

This method must be used to make small adjust-
ments in the contour, because the reshaping is done
point-by-point. For this the user must select the op-
tion “Pointwise Boundary Reshaping” in the “Tools”
menu, or simply press button 6 on the toolbar, Figure
1. Forthwith the boundary turns red with some control
points. From these points it is possible to change the
shape of the contour. For this, the user must click and
drag the control points to their new positions, Figure
2.

The following table lists the interactive behaviors
supported by this tool.

Table 1: Interactive behaviors supported by “Reshap-
ing the Boundary” functionality.

Interactive
Behavior

Description

Boundary
Reshaping

Move the pointer over a control point.
The pointer changes to a circle. Then,
click and drag the control point to its new
position.

Adding a
new control
point

Move the pointer over the boundary and
press theA key. Click the left mouse but-
ton to create a new control point at that
position on the boundary.
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2.3.2 Local boundary reshaping

Local boundary reshaping must be used when it is
necessary to make great adjustments to the initial con-
tour. For this, the user must select the option “Local
Boundary Reshaping” in the “Tools” menu, or simply
press button 7 on the toolbar, Figure 1.

Basically, this method allows the user to draw a line
to define the new shape of the contour. The line must
intersect the initial contour at least in two points to
form a closed contour. This can be used to increase
or reduce the size of the initial contour. Note that it is
possible to increase and reduce the size of the contour
with a single line, Figure 3.

The final contour (Figure 3(h)) is obtained through
a set of logical, arithmetical, and morphological oper-
ations:

• First, a binary image from the initial contour and
another binary image from the new line are cre-
ated, Figure 3(c) and Figure 3(d) respectively;

• Image subtraction between image (c) and (d),
Figure 3(e);

• Selection of the biggest binary object from im-
age (e), and application of a logical OR operator
between image (e) and (d), Figure 3(f);

• Application of a morphological filling in order
to fill the image holes, and then a morphological
close is used to remove the extra lines, Figure
3(g).

2.4 Storage of segmented image
Finally, this interface also allows storing the result
of manual segmentation. The segmentation result is
saved as a binary image, where the segmented object
corresponds to the white pixels and the background to
the black ones.

3 CONCLUSIONS
A graphical user interface was presented in this pa-
per, for manual segmentation of dermoscopic im-
ages. This tool will allow constructing a ground truth
database, in a very simple and fast way, to be used in
the assessment of the automatic segmentation meth-
ods. Moreover, this tool also allows segmenting other
specific regions of interest, and can be used in medical
training.

The developed interface is very simple and intu-
itive, providing to the user a set of tools to achieve the
desired objective, such as the image upload and dis-
play, the manual segmentation, the boundary reshap-
ing, and the storage of segmented image.

Besides the manual segmentation, one of the most
interesting tool is the boundary reshaping, with which

Figure 3:Local boundary reshaping: (a) Initial contour;
(b) Initial contour and a new line to reshape the contour;
(c)-(g): intermediate steps; and (h) Final contour.

the user can correct the shape of the contour previ-
ously done. For this purpose, two distinct methods
were implemented, namely “Pointwise boundary re-
shaping” and “Local boundary reshaping”.

This prototype version was set up based on the re-
quirements and suggestions of dermatologists and is
currently under evaluation in clinical environment.
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